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Performance 
• Background processing 
• Open GL  

Intuitiveness 
• Werkomgeving 
• Snap points & Guide lines 
• Dimensioning 
• Labels 

Architecture 
• Surface painter 
• Schedules 
• Point clouds 

Verbeteringen en project migratie 
• Bibliotheek verbetering 
• IFC verbetering 
• Migratie 

Inhoud





De Template - extra modules - extra bibliotheek met specifieke objecten - extra sufaces

KUBUS KEYMEMBER BE



PERFORMANCE



• Optimaal gebruik van processoren bij het wisselen  
tussen vensters. 

• Open tabbladen of vensters blijven geüpdatet. 

• 3D venster zal 70% sneller openen. 

• Snedes, gevels en 3D documenten zullen 50%  
sneller openen.

Background processing
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• Beheren van  
background  
processing.

Background processing
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• Beheren van background processing. 
Options > Work Environment > Model Rebuild Options

Background processing
01- 9



Betere navigatie in 3D 

• Geoptimaliseerde OpenGL ondersteuning  
voor snellere en betere 3D navigatie: 

• Sneller, 

• Minder tot geen flikkeringen, 

• Regelmatiger, 

• Ook voor grote modellen.

Open GL
01- 10
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INTUITIVENESS



Samenhangend venster in MAC 

• Vergroten/verkleinen als geheel. 

• Fullscreen modus. 

Let op! 
Exit fullscreen modus enkel mogelijk via 
de verkleinknop van het venster.  
ESC werkt hier niet.  

• Paletten docken en snel tonen/verbergen. 
Window > Show/Hide palettes and toolbars  

• Losmaken van tabblad (enkel op MAC). 
Window > Undock Tab (actieve tab) 

WERKOMGEVING
02- 12



Work Environment 

• Work Environment profiel sneller  
aan te aanpassen.  
Options > Work Environment >  
Apply Work Environment Profile

WERKOMGEVING
02- 13



Tabbladen  

• Openstaande tabbladen worden  
meteen geüpdatet via background  
processing. 

• Sneller gebruik van vensters. 

• Contextmenu is afhankelijk van  
openstaande tabblad. 

• Tabbladen zijn te verplaatsen,  
te sluiten, wel of niet te vast te zetten in de tabbladen balk (enkel MAC).  

• Icoontjes geven het type of voortgang (CineRender) aan.  

• Uitroepteken geeft aan dat weergegeven filters anders zijn dan in  
opgeslagen View Settings, dubbelklik om venster te herstellen.

WERKOMGEVING
02- 14



(Window > Pelettes > Favorites) 

Maak gebruik van de favorieten! - Definities  

Default settings : Instellingen van een tool als er niets geselecteerd is. Om te starten met tekenen. 

Selection settings : Instellingen van het geselecteerde element.  

Favorieten : Opgeslagen settings voor een tool die makkelijk opgeroepen en gebruikt kunnen worden. 

Beginnen met tekenen (met favorieten) 

• Het pipetje wijzigt de default settings.  

Tip:  
Roep het pipetje snel op met de ‘alt’ toets. 

• Het activeren van een favoriet wijzigt de default settings.  
Activeer de favoriet door er dubbel op te klikken. 

• Begin met tekenen. 

FAVORIETEN 
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Overschrijf een selectie met een favoriet 

• Maak een selectie van de te wijzigen elementen,  

• Dubbelklik op de favoriet.  

FAVORIETEN
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Opslaan als eigen favoriet (1)  

• Selecteer een element. 

• Kies in het favorites pellet voor Save Current Selection… 

Opslaan als eigen favoriet (2) 

• Ga naar de selection setting of de default  
setting van een element/tool. 

• Kies voor Favorites… 

• Kies voor Save Current Settings  
as Favorite. 

FAVORIETEN
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VLAAMSE favorieten in de KeyMember template 

Voordelen! 
• Veel gebruikte Vlaamse instellingen zijn beschikbaar.  

(Ramen en deuren!) 
• De lagen staan correct ingesteld. 
• Uniforme plannen op het bureau. 
• Hoge tekensnelheid. 
• …

FAVORIETEN
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Pop-up Navigator  

• Geeft mogelijkheid tot vergroten van het werkblad. 

• Tijdelijk uitklapmenu. 

• Publisher Set toegankelijk via Organizer of Navigator.

WERKOMGEVING
02- 19



Quick options 

Snel openen van de menu’s via een knop voor de keuze in  
Quick options: 

• Lagen en lagencombinaties 
• Schaal  
• Partial structure display 
• Pennen 
• Model View Option Combinations 
• Renovatie Filter Options 
• Project preferences

WERKOMGEVING
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Overige 

• De Work Environment indeling  is aangepast. 
User Preference Scheme / Palette Scheme (1) 

• Listing and Labeling in Tool Settings vervallen (2) 
Meer uitleg bij Labels. 

WERKOMGEVING
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Overige 

• Hoofdstuk Model staat niet meer standaard  
aan bij Ramen en Deuren.  

• Werkwijze vervangen door Surface Painter.  
(Zie surface painter)  

• Toch terug aanzetten kan via Options >  
Work Environment > Tool Settings Dialog Boxes. 
Kies hier voor het betreffende tool en zet het  
oogje van het hoofdstuk Model aan.  

WERKOMGEVING
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Snap Guides & Guide References  

• Relevante Snap Guides worden automatisch aangeboden. 

• Extra info (haaks, parallel). 

• Definieer eigen Snap References voor extra Snap Guides 
Aanwijzen of direct oproepen met ‘Q’. 

• Gebruik Snap Referentie als tijdelijk ‘nullpunt’. 

• Oneindig aantal Snap References mogelijk.  

• Snap Guides en Snap References zijn tijdelijk.  

• Tijdelijke ‘Pin’ of ‘Lock to’ functie.

SNAPGUIDES, GUIDELINES & SNAPPOINTS
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(Permanente) Guide Lines 

• Sleep een Guide Line van de kant van het venster in het model. 

• Teken een Guide Line Segment met Shift+L en twee klikken.  
Let er op dat de knop Guide lines actief is. (view > Guide lines)  

• Guide Lines blijven totdat ze expliciet verwijderd worden. 

• Grafisch te verwijderen of tijdelijk te verbergen. 
Verbergen door de knop Guide lines te deactiveren.  
Verwijderen door het contextmenu op te roepen op de guideline  
of in het het menu view > Guide line options 

• Remove All Guide Lines : verwijdert alles 

• Remove Guide Line : verwijdert enkel de aangeklikte guide line 

• Erase Guide Lines : de cursor verandert in een gummetje waarmee  
                                               de guide lines verwijderd kunnen worden

SNAPGUIDES, GUIDELINES & SNAPPOINTS
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Verbeterde Snap Points 

• Nieuwe optie ‘Best Division by Distance’. 

• Verbeterde Snap Point Feedback 

• Snap Points langs tijdelijke Snap Guides. 

• Gehele Polylijnen worden als één geheel behandelt.  
Kies voor ‘Along Entire Element’

SNAPGUIDES, GUIDELINES & SNAPPOINTS
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Dimension Settings 

• Vernieuwde aanduiding  
projectielijn. (1)  

• Ook beschikbaar voor andere maatvoerings-  
gereedschappen bijv. straalmaatvoering enz.  

• Meer maatvoeringssymbolen. (2) 

• Aanwijslijn voor maatvoeringsteksten. (3)  

• Algemene plaatsingsmethoden voor teksten. (4)

DIMENSIONING
02- 26

ARCHICAD 18

ARCHICAD 19

1
2

3

4



Nieuwe petpalet opties bij maatlijnen  

Verplaatsingsmethoden 
• Maatlijnsegment verplaatsen. (1)  

• Punt verplaatsen. (2) 
Bij verplaatsing kan een punt gekoppeld worden aan een element en  
wordt daarmee associatief. 

Splitsingsmethoden 
• Maatlijn splitsen en verplaatsen. (3)  

(bij een punt moet het segment gekozen worden) 

• Maatlijn splitsen (zonder verplaatsing) (4)  
(opdelen aan de hand van een maatlijn segment) 

• Aanwijslijn inkorten of verlengen (5) 

DIMENSIONING
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Dimension Settings 

• Meer snappunten in verdiepingslijnen. 

• Associatief maatvoeren, ook in 1 klik. 

• Koppeling met zichtbare verdiepingen. 

• Zichtbaarheid en koppeling is afhankelijk van de opties in  
Story Settings, Elevation of Section Settings. 

Let op!  
Maatvoering is gekoppeld aan de verdieping.  
Als deze wordt uitgezet in de Story Settings dan is de  
koppeling en dus de maatvoering kwijt. 

DIMENSIONING
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Label Settings 

• Sortering gebaseerd op type label. 

• Uitbreiding van het aantal typen.  

• Beschikbaarheid voor element is te zien in  
Custom Settings > Informatie

LABELS
02- 29
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Labels plaatsen  
 
 
 
 

• Per element kunnen onbeperkt aantal labels geplaatst worden.  

• Per element kan een label meerdere keren geplaatst worden. 
(bijvoorbeeld in verschillende formaten vanwege schaal en/of detailniveau)  

• Labels kunnen associatief of onafhankelijk worden geplaatst.  

• Meerdere elementen labelen met één commando. 
(Document > Document Extras > Label Selected Elements)  

• Hotlinks kunnen vanuit het hoofdbestand worden gelabeld. 

• Aanwijssymbool voor bijv. plafondmaatvoering. 

LABELS
02- 30



Labels KeyMember Editie  

• Afwerking label KM roept BM of Surface eigenschappen van afwerking op. 
 
 
 
 
 
 

• Object label KM roept objectparameters zoals naam, ID etc op. 

LABELS
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Labels KeyMember Editie 
• Ramen en deuren label KM plaatst peilmaatvoering en afmetingen.  
 
 
 
 
 

• Warmteweerstand label KM roept R- of U-waarde op. 
Alleen toepasbaar voor wanden, vloeren, daken en shells  
 
 
 
 

• Veelvoorkomende labels zijn als favorieten toegevoegd.

LABELS
02-32



Meerdere elementen labelen  

• Stel de juiste default in voor het label tool. 

Tip: 
Gebruik de favorieten door te dubbelkikken!  

• Selecteer alle ramen en deuren die gelabeld moeten worden. 

• Ga naar Document > Document Extras > Label Selected Elements.

LABELS
02- 33



ARCHITECTURE



Wat is er voorzien? 

• Toegevoegde fills voor het berekenen en intekenen van de informatie voor de 
regenwatertoets. 

• Gebruik de laag ‘Z Regenwatertoets’ of ‘Info BA Algemeen’. 

• Favoriet ‘BA RWT verharding 50% KME’ toegevoegd als voorbeeld. 

• Het schedule ‘BE-RWT Regenwatertoets - voorbereiding’ laat de gegevens zien  
voor het invullen van de regenwatertoets.

REGENWATERTOETS - BOUWAANVRAAG
03- 35



Herziening werkmethodiek 

Let op!  
In ARCHICAD 18 werd er gewerkt met zone’s voor de regenwatertoets.  
Deze zone’s zijn in ARCHICAD 19 vervangen door de werkmethodiek met fills.  
Ook de schedules zijn hierop aangepast.  

Deze aanpassing is doorgevoerd om het tekenen van meerdere zone’s over elkaar te  
beperken/vermijden.

REGENWATERTOETS - BOUWAANVRAAG
03- 36



Werkmethodiek 

• Het plan is getekend voor de bouwaanvraag.  

• Gebruik op het inplantingsplan de specifieke fills om de aanduidingen op de plannen te doen  
die verplicht zijn voor de regenwatertoets.  
Verander de benaming van de fill NIET. Deze is zeer belangrijk voor de herkenning in de schedules.  
Verander eventueel de arcering en kies de kleuren. 
Gebruik de laag ‘Z Regenwatertoets’ of ‘Info BA Algemeen’. 

Tip:  
De layout van de bouwaanvraagplannen is vaak unaniem voor alle projecten op een bureau.  
Sla de instellingen van de fill op als favorieten in je bureautemplate.  

• Bekijk het schedule om de gegevens in te  
vullen in het document/ de webtoepassing. 
(http://www.integraalwaterbeleid.be)

REGENWATERTOETS - BOUWAANVRAAG
03- 37
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03- 
STATISTISCH FORMULIER - BOUWAANVRAAG

Wat is er voorzien? 

• Toegevoegde fills voor het berekenen en intekenen van de informatie voor het  
statistisch formulier.  

• Gebruik de laag ‘Info BA Algemeen’. 

• Favoriet ‘BA RWT verharding 50% KME’ toegevoegd als voorbeeld. 

• Verschillende zone’s die gebruikt worden tijdens het tekenen. 

• Er zijn verschillende schedules voorzien voor de statische formulieren.  
• BA-A03 Stat. Form. - Collectieve woonvertrekken 
• BA-A04-05 Stat. Form. - Bebouwde oppervlakte 
• BA-A06.1 Stat. Form. - Gebouwoppervlakte huisvesting 
• BA-A06.2 Stat. Form. - Gebouwoppervlakte kelders, zolders en bijgebouwen 
• BA-A06.3 Stat. Form. - Gebouwoppervlakte niet-huisvesting 
• BA-A07 Stat. Form. - Gebouwoppervlakte totaal  
• BA-A08 Stat. Form. - Totaal volume 
• BA-A11 Stat. Form. I - Parkeerplaatsen  
• BA-A12 Stat. Form. I - Sanitaire voorzieningen 
• BA-ALG Stat. Form. - zones info checklist. 

38



Herziening werkmethodiek 

Let op!  
In ARCHICAD 18 werd er gewerkt met zone’s voor de totalen van het perceel en de bestemmingen.  
De zone’s voor de totalen op het perceel zijn in ARCHICAD 19 vervangen door de werkmethodiek  
met fills. Ook de schedules zijn hierop aangepast.  

Deze aanpassing is doorgevoerd om het tekenen van meerdere zone’s over elkaar te  
beperken/vermijden.

STATISTISCH FORMULIER - BOUWAANVRAAG
03- 39

Blijven bestaan

Niet meer in ARCHICAD 19



Herziening werkmethodiek 

Let op!  
De schedules zijn herzien. Ze werken nog met een gelijke codering als in ARCHICAD 18. 
De nummercode komt overeen met de vragen op het statistisch formulier. 

STATISTISCH FORMULIER - BOUWAANVRAAG
03- 40



Werkmethodiek 

• Gebruik tijdens het tekenen de zone tool en de voorziene fills.  

• Verander de benaming van de fill NIET. Deze is zeer belangrijk voor de herkenning in de schedules.  
Verander eventueel de arcering en kies de kleuren. 

Tip:  
De layout van de bouwaanvraagplannen is vaak unaniem voor alle projecten op een bureau.  
Sla de instellingen van de fill op als favorieten in je bureautemplate.  

• Bekijk het schedule om de gegevens in te vullen op het formulier.

STATISTISCH FORMULIER - BOUWAANVRAAG
03- 41



Surface Painter 
• Nieuw palet Surface painter (alleen 3D venster). 

(Window > Palettes > Surface Painter   of   Document > Creative Imaging) 

• Eenvoudig Surfaces in 3D aan te passen.  

• Externe bronnen kunnen gebruikt worden. 
(Surface Catalogus, Bim Components Portal) 

• Ook mogelijk om Surfaces van objecten te veranderen. 

Let op! 
Surface painter zorgt voor een override in de instellingen van  
gebruikte Building Material (1) 

SURFACE PAINTER
03- 42

1



SURFACE PAINTER PALET

SURFACE PAINTER
03- 43

Surfaces geselecteerde elementenBeschikbare Surfaces 

1 2

Preview instellingen

Zoekfunctie

31

• Eenmalig of  
doorgaand verven

2

• Pipetje om Surface uit  
het model te selecteren

• Contextmenu (van een  
materiaal) maakt het 
mogelijk om alle  
elementen te selecteren  
met dit materiaal 

• Dubbelklik om attribuut  
(Surfaces) te wijzigen



Surface painter gebruiken 

Er zijn twee methoden: 
• Kiezen van een surface in het linker kader en dit  

toepassen in het rechterkader. 
• Kiezen van een surface in het linker kader en dit  

in het model toepassen op een element. (verven) 
 

Let op! 
• Preview geeft keuze voor de vlakken die  

geverfd moeten worden.  
• Gebruik TAB om tussen vlakken te springen. 
• Preview in 3D venster van het materiaal.

SURFACE PAINTER
03- 44



 
 

Schedule op basis van Surfaces - Exposed Area  

• Skin Area van elementen, zowel Basic als Composites. 

• Een overzicht van de afwerkingen. 

• Afwerking per element (zichtbare Surfaces). 

• Sub-dialog ‘Reduced Exposed Area’ in Scheme Settings. Kan elementen van een  
te berekenen sufrace oppervlakte aftrekken.  

• Afwerking per opening 

SCHEDULES
03- 45



Surface Areas Complex Profiles 

• Component Areas of Complex Profiles. (1) 

• Calculatie van Surfaces in een profiel o.b.v. een (gedraaide) lijn  
of cirkel. 

SCHEDULES
03- 46
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Detailleren met de Profile Manager 
 
Er kan nu dus ook een oppervlakte berekend  
worden van de verschillende Building Materials  
in een 3D detail! 

De oppervlaktes worden weergegeven in het  
schedule via het Surface wat aan het BM gekoppeld  
is.  

Let op! 
De oppervlakes worden berekend  
aan de hand van een (verplaatsbare) 
recht lijn. 

COMPLEX PROFILE
03- 47

WALL TOOL 
Complex profile



Nieuwe complex profiles in de KeyMember template BE 
Complex profiles direct beschikbaar vanuit de template.  

• Gelamineerd spant KME 
• Herhalend patroon - operator KME 
• Kabelgoot breedte en hoogte variabel KME 
• Keuken SO/VO KME 
• Klossen - breedte en hoogte variabel KME 
• Natuursteen plint - hoogte variabel KME 
• Onderdorpel KME 
• Opening/nis met vrije vorm - operator KME 
• Schuine dakrand - operator KME 
• Speklaag - hoogte variabel KME 
• Ventilatiekanaal - breedte en hoogte variabel KME 

COMPLEX PROFILES
03- 48



Nieuw Building Material  

• Steen - Snelbouw 
• Steen - Snelbouw C 

• Aanpassingen ook doorgevoerd  
bij Composites. 

BUILDING MATERIAL 

Snelbouw

03- 49



Sinds ArchiCAD 18 is het mogelijk om schedules te maken die specifiek artikelnummers en -omschrijvingen bevatten. 

Artikels opnemen in een ArchiCAD-model. 
Sinds ArchiCAD 18: extra informatie toevoegen aan Building Materials. 
Alle wijzigingen in materiaalkeuzes en hoeveelheden worden onmiddellijk doorgevoerd in de meetstaat-voorbereiding. 
Het koppelen van de artikellijst (VMSW of eigen bureau-standaard) kan centraal beheerd worden door slim gebruik te maken van attributen. 

Let op! 
De beschreven werkmethodiek maakt geen live-koppeling tussen het ArchiCAD-model en lastenboek-documenten (xlsx, docx, …). 
Uiteraard kan de XLS-export van ArchiCAD makkelijk geïntegreerd worden in een eigen (VMSW-)meetstaat 

Tip 
Je kan ook een eigen bureau-bestek op dezelfde manier integreren in je ArchiCAD-projecten. 
Het is ook mogelijk om in het model de specifieke product-informatie (merk&type) te bewaren waarop een bestekartikel is 
gebaseerd. 

VMSW 

Voorbereiden van een (VMSW-)meetstaat
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In de template zijn – naast de gekende schedules - een aantal specifieke zaken voor de voorbereiding van een (VMSW-)meetstaat 
opgenomen. 

• Elk Building Material heeft de best passende VMSW-code en –omschrijving meegekregen 

• Er zijn 2 Interactive Schedules aan de template toegevoegd: 
• VMSW Hoofdstukken - 10-90 - Detail meetstaat 

Deze schedule geeft een uitgebreidere samenvatting dan het algemeen overzicht. 
• VMSW Algemeen - Samenvattende meetstaat 

Deze schedule bevat een algemeen overzicht van de meetstaat. 

VMSW 

Voorbereiden van een (VMSW-)meetstaat
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In de template zijn alle Building Materials reeds voorzien van  
de juiste codering volgens BBW 2014 van het VMSW.  
De codering van is ingevuld als ID; de omschrijving van het hoofdstuk  
is ingevuld als Description. 

Tip: 
Er kan onmiddellijk met de template begonnen worden met  
modelleren en de Interactive Shcedules zullen ingevuld worden,  
met artikelnummer en –omschrijving. Uiteraard moet er op een  
later moment verder verfijnd worden (materiaalkeuzes e.d.),  
maar op deze manier is er van bij de start een goede voorbereiding  
van de bestekfase. 
 
Uiteraard kunnen er - op basis van de opgenomen voorbeelden -  
veel meer artikels toegevoegd worden. 

VMSW 

KeyMember template BE
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Artikels (nummer en omschrijving) kunnen op 2 manieren worden toegevoegd aan de Building Materials in een model: 

1. Manueel – bij aanmaak van een nieuw materiaal wordt de ID en de Description correct ingevuld: 
Voordeel: werkt snel voor 1 artikel – het ontwerpproces moet niet ‘onderbroken’ worden. 
Nadeel: zeer omslachtig bij uitgebreide modellen waarbij veel artikels moeten toegevoegd worden. 

2. Via de Attribute Manager kunnen de nodige artikels worden binnengehaald: 
Voordeel: je kiest enkel de artikels die op dat moment van toepassing zijn (geen vervuiling). 
Nadeel: je attributen moeten goed georganiseerd zijn (risico op ongewenste overschrijvingen). Gebruik bij voorkeur de KeyMember  
                      attributen lijsten waarin alle artikelen al voorbereid zijn. Deze zijn beschikbaar bij de T&T 082 : VMSW-meetstaat 

Let op! 
De template is een aanzet naar de artikelen uit het VMSW-bestek.  
Elk project dient verder gespecificeerd te worden.

VMSW 

Artikels toevoegen aan het model
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• Artikels manueel toevoegen: 
Via de Building Materials. Add new. 

• Artikels toevoegen via attributen: 
Om Building Materials (en de bijhorende artikelnummers en –omschrijvingen) via de Attribute Manager toe te voegen aan een project, ga je 
als volgt te werk: 

• Kies in het actieve project voor  
Options > Element Attributes > Attribute manager… 

• Kies voor Open. 
• Blader naar het bestand “VMSW_BBW-2014_BM_Hfdst-xx.aat”. 
• Selecteer de gewenste Building Materials en voeg ze toe By index -  

vink hierbij Include Cut Fills en Surfaces uit. 
• Kies rechts onderaan voor Apply en kijk na of enkel de  

Building Materials worden toegevoegd (en er geen Fills of  
Surfaces ongewenst worden overschreven) 

• Bevestig met OK, de gewenste artikels zijn nu beschikbaar  
onder Building Materials 

Tip: 
Je kan meerdere Building Materials selecteren door de Cmd/Ctrl toets te gebruiken bij het aanklikken van de materialen in de 
rechterkolom. 

VMSW 

Artikels toevoegen aan het model
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BIMx - verbeterde export 

• Extra info hyperlinks/data toevoegen bij het publiceren van BIMx Hypermodel. 
(alleen BIMx PRO) 

• Standaard BIMx schedule. 
• Eigen schedule. 
• Data uit Tags & Categories.  

• Informatie over zones, naam, oppervlakte en volume.  

• AirPrint support vanuit mobile apparaten 2D en 3D. (alleen BIMx PRO) 

• Toegang tot ‘Cloud Storage’ bvb Google drive / iCloud /Dropbox etc.

SCHEDULES
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Point Clouds 

• Inlezen van *.e57 en *.xyz bestanden. 

• Point Clouds zijn snapbaar met de  
nieuwe snapfunctionaliteit.  

• Point Cloud zichtbaar in alle vensters 

Tip: 
Bekijk ook onze Tip & Trucs  
op de website.

POINT CLOUDS
03- 56



Point Clouds importeren  

• Import binnen ARCHICAD. 
(File > File Special > Import Point Clouds)  

• Point Cloud wordt omgezet naar een bibliotheek (linked library) met  
1 object dat direct geplaatst wordt. 

POINT CLOUDS
03- 57

1

2 3

Positie van het .LCF bestand (lokaal) 

Naam Object 

Naam .LCF bestand

1

2

3



Point Clouds gebruiken  

Bereik instellen in ARCHICAD  
• Stel een klein bereik in (enkele mm), om nauwkeuriger te werken; 

• In plattegrond: Selection Settings van het object. (1) 
• In sneden: bereik in gevel- en doorsnedelijn. 
• In 3D: instellen van de 3D Cut-Away. 

Omgaan met afwijkingen 
• Wees ervan bewust dat een gebouw altijd afwijkingen heeft.  

Grootte bestand 
• Een Point Cloud wordt gemaakt uit verschillende scans en kan dus  

opgedeeld worden in kleinere Point Clouds. 
• Voordat een scan wordt gemaakt wordt een puntendichtheid bepaald,  

ga hiermee nauwkeurig mee om. 
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Bekijk ook zeker onze T&T 093  
voor het inlezen van point cloud.
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Verbeteringen en project migratie



Ramen en deuren verbeteringen 

• Verbeterde UI (User Interface); (1)  

• Duidelijk structuur in hoofdthema’s. 

• Snelkoppelingen vanuit de hoofdtabbladen. 

Tip: 
Bekijk ook onze Tip & Trucs op de website. 

• Diverse verbeteringen in Ramen en Deuren in samen- 
werking met Graphisoft.  

• Deuren met zijlicht, oprekbaar voor specifieke  
afmetingen. 

• Combinatiedeuren beter te combineren met ramen. 

Bibliotheek verbeteringen
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Ramen en deuren KeyMember Editie  

• Kleur en zwart/wit weergave in Ramen- en deurenstaat. 

• Gebruikte maatgevende afmetingen in Ramen en deuren via Raam en Deurmaker KM  
gekoppeld aan Interactive schedule. 

• Peilhoogten te koppelen aan elk referentieniveau (project zero, levels en b.k. afwerkvloer). 

• Overig verbeteringen: 

• Verbetering in afstand maatvoering (Ramen- en deurenstaat).  

• Ramen en deuren objecten KM hebben verbeterde gebruikers interface. 

• Geautomatiseerde keuze surface ‘ niet van toepassing’ bij roede, latei etc tbv uittrekstaat. 

• Keuze type markering geeft keuze uit alle maatvoeringstics zoals bij andere gereedschappen. 

KeyMember Editie ARCHICAD 19
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Nieuwe objecten  

• Badkamer accessoires, radiatoren, elektrische  
apparaten. 

• Speeltuin elementen. 

• HWA hoekgoot. 

• 3-delige en 6-delige schuiframen. 

• Flatscreen TV. 

Bibliotheek verbeteringen
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Bibliotheek uitbreidingen KeyMember Editie  

• Uitbreiding van 2D Electra symbolen. 

• 2D draagrichting symbool. 

• Overige object toevoegingen: 

• Meer typen toegevoegd aan Elektrisch deurslot & Sleutelkluis.  

• Afwerking Label werkt nu ook voor Slabs en Shells. 

• Verkoopmaatvoering in mm met afronding op 50 en 100mm. 

• Zonestempel laat ook Master ID zien van hotlinked modules. 

KeyMember Editie ARCHICAD 19
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• Toevoegingen voor het tekenen van riolerings- / elektriciteitsplannen  

• 2D energiebocht (BE) Bovenaanzicht en zijaanzicht 

• 2D tekst in Schedules als lijst toonbaar. 

• 2D Transformator 

• 3D Septische put (BE) parametrisch!

KeyMember Editie ARCHICAD 19
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• Verbeterde CineRender Scenes;   

• Start KME: Basis renderscene voor een snel, maar goed resultaat  

• Interieur en exterieur renderscenes met verbeterde instellingen 

• Professionele renderscene incl. HDRI (Ext) voor kwalitatief hoogwaardige rendering 

RENDER SCENES
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• Bij importeren van IFC-bestanden is er de keuze voor  
aanmaken nieuwe attributen of gebruik van BM.  

• Verbeterde GUID voor Project ID, Site ID en Building ID  
bv. meerdere gebouwen op een terrein. 

• Verbeterde import van MEP elementen. 

• Updaten van IFC model heeft nieuwe mogelijkheden voor  
het updaten van de data.  
(File > File Special > IFC 2*3 > Update with IFC model)  

• Data mapping (IFC Scheme Setup) van parameters mogelijk op een hoger niveau.  
Alle elementen die deze parameter hebben worden in 1 keer voorzien.  

• Export IFC data naar BIMx 
Alleen bij BIMx Hyper Model

IFC VERBETERINGEN
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• Standaard Surface Catalogus uitgebreid en betere doorzoekbaarheid door extra steekwoorden. 

• Nieuwe Diagnostic Tool voor BIMserver. 

• Export van lagen in een layout naar PDF. 

• Verbeterde interface 3D Window Settings.  

• Find and Select uitgebreid met Surface criteria. 

OVERIGE NIEUWE FEATURES
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• MAC: mogelijk niet in als volledig scherm -> Legacy Modus aanpassen. 

• Stappen tbv Migratie; 

1. Backup maken in ARCHICAD 18 

2. Bestand openen in ARCHICAD 19 

3. Koppelen van de juiste bibliotheek + eventueel subset bibliotheek 

Tip: 
Bekijk ook onze Tip & Trucs op de website 
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De ARCHICAD basiscursus is gericht op iedereen (architecten, ontwerpers en tekenaars) die zoveel mogelijk gebruik willen maken van een modelgebaseerde 
werkwijze. In deze cursus zijn de oefeningen gericht op het opzetten van een goed BIM model. Daarbij hoort uiteraard het genereren en uitwerken van 
bouwkundige tekeningen, kozijnstaten, stuklijsten, enz. Tijdens de cursus wordt geoefend met een model en wordt vooral aandacht besteedt aan fases na 
VO. 

Je leert een project te structureren voor het aanmaken van Views. Dit komt de snelheid bij het maken van lay-outs en het verwerken van wijzigingen ten 
goede. Daarnaast komen ook allerlei tips aan bod om sneller, makkelijker en slimmer te werken. Denk aan het werken met Hotlinked modules, automatisch 
dimensioneren, templates/bureauonderleggers, werkmethodieken, enz. 

De basiscursus duurt 6 dagen en is opgebouwd uit 4 basisdagen (2 x 2 achtereenvolgende dagen) en 2 basismodules naar keuze.

NIEUWE CURSUSSEN KUBUS 
BASISCURSUS 4 + 2 dagen
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Ontwerpen en presenteren  
objecten, favorieten, snelle rendering, bimx 
Werktekeningen en detailleren  
Maatvoering, detailleren, eigen ramen en deuren 

Bureaustandaard maken  
template, werkomgeving, attributen 
Modelleren voor renovatie, het gebruik pointclouds 
Renovation tool, morph, point cloud scans 

Geavanceerde functies in ARCHICAD  
complexe daken, vliesgevels, hotlinken 
Opfrisdag 
basiskennis terug opfrissen 

Coördinatie, revisie en data-extractie 
issuemanagement, wijzigingen in uitvoeringsfase, 
aanpassingen, meetstaten

NIEUWE CURSUSSEN KUBUS 
Basismodules
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Visualiseren en renderen  
CineRender- en SketchRenderEngine, animaties, BIMx, zon-
studies, batchrenderen. 

Energieverbruik en (milieu-) kostenberekening 
EcoDesigner STAR, LEED, BREEAM, KeyMember EQ add-on 

OPEN BIM en IFC  
samenwerken met bouwpartners, uitwisseling tussen 
programma’s 

Eigen ARCHICAD objectenbibliotheek 
GDL programmeren 
Installaties modelleren 
installatiemodellen, MEP modeler

NIEUWE CURSUSSEN KUBUS 
Gevorderden cursus ARCHICAD 
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